Kak 10n0JHUTHL KOMIUWJISIIUEH METAJAHHBIX MMPOEKT
Visual Studio ¢ npumepamu u3 SDK nanoCAD ¢ nomMoumb1o
pacuupenus Qt VS Tools.

Pexomenayercs ucnons3oBath cpeay Visual Studio 2019, toolset vi42 u Qt 5.15.1.
1. Ycranoure Qt VS Tools

B Visual Studio (Menu -> Extensions -> Manage Extensions)

Extensions  Window  Help

Msight
Ot VS Tools
Manage Extensions

Customize Menu...

Puc. 1

Manage Extensions

b Installed Relevance - af

i Qt Visual Studio Tools @ -

The Qt V5 Tools for Visual Studio 2019 allow developers to use the Created By: The Ot Company Ltd.

standard development envirenment without having to worry ab... Version: 2.9.1.6

Search Results Installs: 468469

p Controls

b Templates Qt VS CMake Tools

b Tools In the V52019 CMake QT project, add the Add QT Class command to
the right-click menu of the folder.

4 Visual Studio Marketplace

Pricing Category: Free
Rating: # # 5 (44 Votes)

b Updates (1)

P Roaming Extension Manager QtitanDataGrid
QtitanDataGrid highly flexible, fast and easy to manage grid control
for Visual Studio C++ based on Ot Framework

Trial

VisualGDB

Integrates DB, Make, CMake and Ot into Visual Studio.

Seamless developing, building and debugging projects based on G...
Trial

Atomineer Pro Documentation Trial
Source-code documentation-comment creation and maintenance,
and other documentation-related tools.

Trial

Aspose.Page for C++ Scheduled For Install:
Load, manipulate and convert PostScript PS, EPS and XPS files to PDF None

and raster images from within C++ applications.

Scheduled For Update:
Trial

MNone

GroupDocs.Metadata Cloud SDK for .NET + Scheduled For Uninstall:
1 None
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2. Jlo6aswTe Bepcuto Qt B pacmmpenne Qt Vs Tools

Extensions  Window
MNsight
Ot VS Tools

H Manage Extensions gt.ic

Customize Menu... Launch Ot Designer

Launch Ct Linguist

Open Ot Project File (.pro)...

Options
Ot Versions

Puc. 3

Options

Search Options (Ctrl+E) P Default Version Haost Path Compiler

Database Tools ~ & 5.15.1_msvc2019 64  Windows ¥ T CAQH5.15.1\msvc2019 84 msve
Graphics Diagnostics @ <add nen
IntelliCode
Live Share
MNuGet Package Manager
Python
Ot
General
Legacy Project Format
Test
Test Adapter for Google Test
Text Templating
Tools for Unity
Web Forms Designer
Web Performance Test Tools
Windows Forms Designer

s ErE A
Ot wersion>

A ¥ T T TTT

e RN CIRENE RN
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3. Ho6aswTe nepemennyto cpenanl QtToolsPath = C:\Q{\5.15.1\msvc2019_64\bin u
QtRoot = C:\Qt\5.15.1\msvc2019 64

Haxxmure knaBumm Win+R Ha knaBuarype, BBenure sysdm.cpl u Haxxmute Enter.

' BoinonHnte

BeeguTe MMA Nporpammel, Nankw, JOKYMEHTA WAK pecypca

1= MHTepHeTa, KoTopble TpeByeTca oTKpBITE.
Orpoms: | S

Puc. 5

Ha Bkimagke «I[OHOJ'IHI/ITCJ'IBHO» HQXXMHUTEC KHOIIKY «HepeMCHHBIC CpEanl...»

CBOWCTEE CHCTEMBI X

WMma komnetoTepa OBopynosaHue
HononHuTensHo JawmnTa cUCTEME YaaneHHeli gocTyn

Heofxomimo MMETE NpaBa aoMWHUCTRATOPAE ANA M3MEHEHWA BoNBWWMHCTEA
MepeYncneHHbX NapaMeTpos.

BricTpoaeicTene

BuzyaneHble 3hderTel, MCNONb30BSHWE NPOLECCOPE, ONEPaTUBHOIM 1
BMPTYaNEHOM NaMATHA

TNapameTpebl...

[MNpogunm nonszoBatensi

MapameTpebl paBoyero cToNa, OTHOCALWWECH KO BXOMOY B CMCTEMY
[apameTpel...

Barpyaxa W BOCCTaHOBNEHWE

Barpyﬁr(a W BOCCTaHOBNEHWE CUCTEMBI, OTNaA0YHaA MHPOPMaUMA

[lapameTpel...

Eﬂ%peMEHHble cpemb... i

Dk Oﬂma MprMeHTs
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B pazgene «IlepemenHbie cpeabl MOIb30BATEN Y (€CIU TPEeOyeTCs U3MEHEHHE TOJBKO IS
TEKYIIETo NMoyib30Barelis) uin « CUCTEMHbBIE TIEPEMEHHBIC» HAXKMUTE KHOIKY «COo31aTh...»

MepemerHbie cpeapl X

DEF]EMEHHI:IE Cpeibl NONB30OEATENA 4NA arsen

| MepemenHan 3Ha4YEHNE

Co3gate... MameHnTs... ¥aanute
CHCTEMHEIE MEPEMEHHEIE
MepemenHan 3HAYEHNE i
— r—. - e
W
— - i - L - . — ol ol i -
Cozaate... zmeHNTE. .. Yaanute
QK Otmena
Puc. 7

Beeaute B none «Mms nepemennoit:» QtToolsPath, a B «3HaueHne nepeMeHHON:» MyTh K
nanke C:\Qt\5.15.1\msvc2019 64\bin. Eciu y Bac Qt jexuT B JApyroM MecTe WIU
YCTaHOBJICHA JIpYyTasi BEPCUs, CKOPPEKTUPYUTE My Th.

Hoean none30BaTensCKan nepemeHHan X

Hrma nepemerHo: | CtToolsPath ‘

JHa4EHWE NEPEMEHHDIA: | CAGH3.15. 1 msvc2019_B4\bin ‘

OB3op katanora... OBzop dainos.. 0K OTraena

Puc. 8



Amnanoruyso s nepemeHHort QtRoot = C:\Qt\5.15.1\msvc2019 64

Hoean none30BaTENbCKEA nepemMmeHHan X

Hra nepemerHo: | CtRoot ‘

JHa4EHWE NEPEMEHHDIA: | CAGH3.15. 1 vmsve2019_64 ‘

OB3op katanora... Otzop dainos.. 0K OTmena

Puc. 9

4. B daiine .vcxproj 1eneBoro mpoekTa 3aMmeHure ctpouky <keyword>...</keyword> nHa
<keyword>QtVS v304</keyword> B pazaene <PropertyGroup Label="Globals">

Mo>xHO 100 OTPENaKTHPOBATh €T0 B TEKCTOBOM PEIAKTOpE, MO0 OTKPHITH MPOEKT B Visual
Studio, HaXkaTh MO HEMY MPAaBON KHOIKHU MbIIIK U BbIOpaTh MyHKT Unload Project.

earch Solution Explorer (Ctri+x) peoins
71 Solution 'HelloQt' (1 of 1 project)
b [l Hellofd

Build

Rebuild

Clean

View

Analyze and Code Cleanup
Project Only

Retarget Projects

Scope to This

Mew Solution Explorer View

Build Dependencies

Add

Class Wizard... Ctrl+5Shift+X
Manage NuGet Packages...

Set as Startup Project

Debug

Cut Ctrl+X

Remove

Rename

Unload Project

Puc. 10



3aTeM oTpeaakTupoBath ¢aiia B cpeae Visual studio

HelloGt.vocproj & X
=] <PropertyGroup Label="Globals

{ES437F42-2BB7-495D-82A1-B488D9BC3+

Qtvs v3ied
scerHelloQt 2502

Puc. 11

u HaxaTh Reload Project B KOHTEKCTHOM MEHIO TPOEKTa

1 Solution 'HelloQt' (0 of 1 project)
b [ HelloQt (unloaded)
Reload Project

Puc. 12

5. Ortxkpoitte mpoekT B Visual Studio u B pacmupenun Qt VS Tools BeiOepute Convert

custom build steps to Qt/MSBuild

Extensions  Window Search (Ctrl+Q pe
Nsight
Ot V5 Tools
Manage Extensions B qtio
Customize Menu... EZ Launch Ot Designer
Launch Gt Linguist
Open Ot Project File (.pro)...
Import .pri File to Project...
Export Project to .pri File...

e
B

Create Basic .pro File...

Ot Project Settings

HelloCt

Convert custom build steps to Qt/M5Build

Options

Ot Versions

Puc. 13

B nosiBuBIIEMCS IMAJIOTOBOM OKHE HaXXKMHUTE «Jla»




Project Conversion

Do you really want to convert all projects?

Her

Puc.14

6. Ho6Gasbte smemeHT «kiacc Qt Widget ¢ makpocom Q_OBJECT» u coxpanuts ¢aiin

Menu -> Project -> Add -> Newltem...

1 Selution 'HelloQt' (1 of 1 project)

4 [T Allans

Build

Rebuild

Clean

View

Analyze and Code Cleanup
Project Only

Retarget Projects

Scope to This
Mew Solution Explorer View

Build Dependencies

¥1 New ltem... Ctrl+Shift+A Add
Puc. 15

Qt > Qt Widgets Class -> Add



Add Mew Item - HelloQt
4 |nstalled Default

4 Visual C++ ot
Ot Class
Formatting
Ul
MFC

Qt Dialog Form File (Button Bottom)

Qt Dialog Form File (Button Right)

Qt MainWindow Form File

. Qt QML File
Utility

Property Sheets
Test
HLSL
CUDA11.3
Ot

Graphics

Qt QML Module Definition

Ot Resource File

Ot Translation File

P Online . Qt Widget Form File

Ot Widgets Class

Name: QtWidgetsClass

Location: i arsen’,Downloads',M( .6053\samples\NRX\HelloQt\,

Puc. 16

Haxmute Next

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Visual C++

Type: Visual C++

Adds a Ot Widgets class to the project.




Ot Widgets Class Wizard

Welcome to the Ot Widgets Class Wizard

This wizard will add a new Qt Widgets class to your project. The wizard creates a h and .cpp
file. It also creates a new empty form.

To continue, click Next.

[ < Previous | [ Finish ]
Puc. 17

Hactpoiite kinacc u Haxxkmute Finish



Ot Widgets Class Wizard

Welcome to the Ot Widgets Class Wizard

file. It also creates a new empty form.

Class Mame:

Base class:

This wizard will add a new Qt Widgets class to your project. The wizard creates a h and .cpp

|QtWidgetsClass

| | QMainWindow

User Interface (i) file:

Ui Class Inclusion as:

|QtWidgetsClass.ui

| ® Member

Header (.h) file:

) Member Pointer

() Multiple Inheritance
Insert QOBJECT macro

|QtWidgetsClass.h

Source (.cpp] file:

\QtWidgetsClass.cpp

| [] Lower case file names

|<Previous||

Next > | | Finish

| |

Cancel

Puc. 18

7. Hob6asbte ¢uar /Zc:referenceBinding-




Menu -> Project -> Properties -> Configuration Properties -> C/C++ -> General ->

Additional Options
HelloQt Property Pages ? X
Configuration: | Active(Debug NCAD) ~ | Platform: | Active(x64) = | Configuration Manager... .
Debugging ~ | All Options
WC++ Directories M Yustdafx.h /MP fifcOutput "C:\Users\arsen\Downloads ~
Ct Project Settings WNC_SDK_22.0.5944.3726.6053\samples\NRX\HelloGt\. \. \trash-x64\HelloGt\Debug NCADY" /GS
b Ct Meta-Object Compi /W3 /Gy fZowchar_t /1"CAGH\S.1 5.1"-.m§vc20'| 9_64\inFIude\" S1"CAGS 5.1\msvc201'9_64\include
b Ot Uset inteiface Coy YWOtCore" /M1"CACGS.15. 1 msve2019_ 6N include\CtGui” /1" CAOHS5.15. 1 \msvc2019_64include
F WOtWidgets" /1"CAO5.15.1\msvc2019_84M\include\QtWinExtras" /1"CAGt
AR 15.15.1\msvc2019_64\include\QEXml" /1"C:AQHS.15.1\msve2019_64\include\ QtANGLE" /1"C:
General “Program Files\Nanosoft\nanoCAD x64 22.005DK\includeharxgate” /1"C:\Program Files\Nanosoft
9 ] )
Optimization ‘nanoCAD x64 22.005DKNinclude” /1"C:\Program Files\Nanosoft\nanoCAD x64 22.005DK\include
Preprocessor “KernelBase\include" /1"C:\Program Files\Nanosoft\nanoCAD x84 22.005DK\include\Kernel\include”
Code Generation /1"C:\Program Files\MNanosoft\nanoCAD x84 22.00\5DK include\Kernel\Devinclude" /1"C:\Program
Files\Manosoft\nanoCAD x64 22.00SDK\include\Kernel\Devinclude\DbRoot" /I"C:\Program Files
e YManosoft\nanoCAD x64 22.005DKNinclude\Drawinghinclude” /I"C:\Program Files\Nanosoft
Precompiled Heade YnanoCAD x64 22.005DK\include\Drawing\ActiveX" /I"C:\Program Files\Nanosoft\nanoCAD x64
Output Files 22.005DKN include-x64" /1"C:\Program Files\Nanosoft\nanoCAD x84 22.005DK\include-x64\Drawing
Browse Information YActiveX" /I"C\Program Files\Manosoft\nanoCAD x84 22.005DK include-x64\ Drawing\ActiveX
Eetainalinckides YOdaX" /1"CAProgram Files\NanosoftinanoCAD x84 22.00SDK\include\MAPI" /["C:\Program Files
YManosoftinancCAD x64 22.00\5DK) include\nmegate” /Zi /Gm- /Od /Fd"C\Users\arsen\Downloads
Advanc.ed YWNC_SDK_22.0.5944.3726.6053\samples\NRX\HelloCQt\. \.\trash-x64\HelloOt\Debug NCAD
All Options \HelloGQt.pdb" /Zciinline /fp:precise /D "_WING4" /D "WIN32" /D "_DEBUG" /D "_WINDOWS" /D <
Command L"ne U CRDE N S ol PWRADTOY M PR AN S0 AR I e nennt sm MAAIR I M
[: Linker Additional Options Inherit from parent or project defaults
b Misineles) Tney e 7 creferenceBinding-
[ XML Document Genera
[ Browse Information "
< >
| Ortmena MpuMeHNTE

8. CobepuTte MpoOeKT.

Puc. 19

9. 3arpy3ure CKOMOWIMPOBAHHBIN MOAYJb B nanoCAD.

KoMaH1bl NpriIoKeHNsl CTaHyT AOCTYIHBI B KoMaHaHOU cTpoke nanoCAD mocine 3arpy3ku.

[IpumMep nonyuuBIIETOCA KOJA:

QtWidgetsClass.h

#pragma once

#include <QMainWindow>

#include "ui_QtWidgetsClass.h"

class QtWidgetsClass

{
Q_OBJECT

public:

: public QMainWindow

QtWidgetsClass(QWidget *parent = nullptr);
~QtWidgetsClass();

private:

Ui::QtWidgetsClassClass ui;

}s
QtWidgetsClass.cpp




#include "stdafx.h"
#include "QtWidgetsClass.h"

QtWidgetsClass: :QtWidgetsClass(QWidget *parent)

: QMainWindow(parent)
{
ui.setupUi(this);
}
QtWidgetsClass::~QtWidgetsClass()
{}
stdafx.h
//
// Konupait (C) 2019, 000 «HaHOCOT pas3paboTka». Bce npaBa 3awWweHbl.
//

// DaHHOoe nporpamMmHoe obecrneyeHue, BCe WUCKWYUTE/IbHblE MpaBa Ha Hero, ero

// BOKYMeHTauMAa M COMpOBOAUTE/IbHble MaTepuansl npuHaanexat 000 «HaHocodpT paspaboTkax».
// DaHHOe nporpammHoe obecnevyeHue MOXeET MCMOAb30BaTbCA MNMpU pa3paboTke U BXOAUTb

// B cocTaB pa3paboTaHHbIX MPOrpaMMHbIX MPOAYKTOB MpuU COGNOAEHUU YCIOBUMA

// VCcnonb30BaHMA, OrOBOPEHHbIX B «J/IMLEH3MOHHOM [LOrOoBOpe MpUCOeUHEHUA

// Ha vcnonb3oBaHue nporpammel Ana 3BM «Mnatdopma nanoCAD»».

// DaHHOe nporpammHoe obecneveHue 3alWWWEHO B COOTBETCTBUM C 3aKOHOAATE/NbCTBOM
// Poccuitckoit Gepepauun 06 MHTENNEKTYaNbHON COBCTBEHHOCTW U MeXAYyHapOAHbIMU
// NpaBOBbIMW aKTaMU.

// Wcnonb3ys faHHOe MnporpamMMHoe obecrne4vyeHue, ero AOKYMEHTaLuKw U
// conpoBoAuTeNbHble MaTepuanbl Bbl COrjawaeTecb C YC/JOBUAMU UCMO/b30BaHMUA,
// yKa3aHHbIMKU BblLe.

#pragma once

//- 'DEBUG workaround' below prevents the MFC or ATL #include-s from pulling

//- in "Afx.h" that would force the debug CRT through #pragma-s.

#if defined(_DEBUG) && !defined(NC_FULL_DEBUG)

#define _DEBUG_WAS_DEFINED

#undef _DEBUG

#pragma message (" Compiling MFC / STL / ATL header files in release mode.")
#endif

#pragma pack (push, 8)
#pragma warning(disable: 4786 4996)
//#pragma warning(disable: 4098)

#define STRICT
#ifndef VC_EXTRALEAN
#define VC_EXTRALEAN //- Exclude rarely-used stuff from Windows headers

#tendif

//- Modify the following defines if you have to target a platform prior to the ones specified below.
//- Refer to MSDN for the latest info on corresponding values for different platforms.

#ifndef WINVER //- Allow use of features specific to Windows 95 and Windows NT 4 or
later.

#define WINVER ©x0501 //- Change this to the appropriate value to target Windows 98 and
Windows 2000 or later.

#endif

#ifndef _WIN32_WINNT //- Allow use of features specific to Windows NT 4 or later.

#define _WIN32_WINNT ©x0501 //- Change this to the appropriate value to target Windows 2000 or
later.

#tendif



#ifndef _WIN32_WINDOWS //- Allow use of features specific to Windows 98 or later.
#define _WIN32_WINDOWS ©x0501 //- Change this to the appropriate value to target Windows Me or

later.
#tendif

#ifndef _WIN32_IE //- Allow use of features specific to IE 4.0 or later.
#define _WIN32_IE 0x0501 //- Change this to the appropriate value to target IE 5.0 or later.

#tendif

#define _ATL_APARTMENT THREADED
#define _ATL_NO_AUTOMATIC_NAMESPACE

#define _ATL_CSTRING_EXPLICIT_CONSTRUCTORS
//-

Turns off ATL's hiding of some common and often safely ignored warning messages

#define _ATL_ALL_WARNINGS

#include <afxwin.h>
#include <afxext.h>
#include <AtlBase.h>
#include <AtlCom.h>
using namespace ATL ;

#include "dbxHeaders.h"
#include "AcExtensionModule.h"

#include <QMessageBox>
#include <QHBoxLayout>
#include <QLabel>
#include <QLineEdit>
#include <QPushButton>
#include <QWindow>

#include "QtWidgetsClass.h"

#pragma pack (pop)

#ifdef _DEBUG_WAS_DEFINED
#define _DEBUG

#undef _DEBUG_WAS_DEFINED
#tendif

stdafx.cpp

Konupant (C) 2019, 000 «HaHocodT pa3paboTka». Bce npaBa 3awmuweHsl.

[laHHOe nporpammHoe obecneyeHue, BCe UCK/IWYUTENbHbIE MpaBa Ha Hero, ero
JOKYMEeHTAauusa M COonpoBOAUTENIbHbIE MaTepuanbl npuHagnexat 000 «HaHocodT paspaboTkax.
[JaHHOe nporpammHoe obecrneyeHue MOXET MCMNONb30BaTbCA Npu pa3paboTke U BXOAUTb

B COCTaB pa3paboTaHHbIX MPOrpaMMHbIX MPOAYKTOB MpuU COBNOAEHUU YCIOBUMA
MCNONb30BaHWA, OrOBOPEHHbIX B «J/IMLUEH3MOHHOM [OroBope rnpucoeanHeHunn

Ha ucnosib3oBaHue nporpammbl ana 3BM «lnatdopma nanoCAD»».

[laHHOe nporpamMMHoe obecrneveHve 3auueHO B COOTBETCTBUM C 3aKOHOAATE/IbCTBOM
Poccuitckoit Gefepauun 06 MHTENNEKTYaNbHON COBCTBEHHOCTU U MeXAYHapOAHbIMU
NpaBOBbIMM aKTaMu.

MCI'IOJ'II:ByFl AaHHOEe nporpamMmHoe O6ECI'IE‘-IEHVIE, ero AOKYMeHTauuw u
conpoBoanTesibHble MaTepUuasbl Bbl COornawaetecb C ycioBUAMU UCNOSIb30BaHUA,
YKa3aHHbIMK Bbllle .

stdafx.cpp : source file that includes just the standard includes
HelloNRX.pch will be the pre-compiled header

//- Some CString constructors will be explicit



// stdafx.obj will contain the pre-compiled type information
#include "stdafx.h"

// TODO: reference any additional headers you need in STDAFX.H
// and not in this file

HelloQt.cpp

// Konupait (C) 2019, 000 «HaHoco¢T paspaboTka». Bce npaBa 3awwuweHbl.

// [aHHoe nporpammHoe obecneveHue, BCe MUCKJYUTENbHble NMpaBa Ha Hero, ero

// BOKYMeHTauuAa M COMpoBOAMUTE/IbHbIE MaTepuanbl npuHagnexat 000 «HaHocodT pa3paboTka».
// [aHHoe nporpammHoe obecrne4veHne MOXeT MCMNONb30BaTbCA MNpuU pa3paboTke M BXOAUTb

// B cocTaB pa3paboTaHHbLIX MPOrpaMMHBIX MPOAYKTOB MpU COBNOAEHUU YCIOBUNA

// “Cnonb30BaHUA, OroBOPEHHbIX B «JIMLEH3MOHHOM AOrOBOpEe MPUCOEeAWHEHUA

// Ha ucnonb3oBaHue nporpammbl ana IBM «lnaTpopma nanoCAD»».

// DaHHOe nporpamMmHoe obecrnevyeHue 3awWMeHO B COOTBETCTBUM C 3aKOHOLATe/IbCTBOM
// Poccuiickoih Gepepauun 06 MHTENNEKTYaslbHOW COHBCTBEHHOCTU W MeXAYHapOAHbIMM
// NpaBOBbIMM aKTaMu.

// Vcnonb3ys paHHOe MporpamMmMHoe obecneveHue, ero AOKYMEHTALUMWKW W
// conpoBoauTenbHble MaTepuasnbl Bbl COrjawaeTecb C YC/JOBUAMU MCMOJSIb30BaHUA,
// yKa3aHHbMK Bble.

#include "stdafx.h"

#include "hostUI.h"
#include "hostQt.h"

extern "C" _ declspec(dllexport) bool showDialog(HWND parent)

{
auto win = new QWinWidget(parent);
win->showCentered();

QMessageBox: :about(win, "QtTests.dll", "Hello, hostQt.dll (based on
gtwinmigrate\\examples\\qtdll)!");

delete win;

return TRUE;
}

void helloQtModalDlgCmd()

{
acutPrintf(L"\nHello, hostQt.dl1l!\n");

showDialog(adsw_acadMainWnd());

}

hostUiPaletteSet* m_pPalSet = NULL;

HINSTANCE _hdllInstance =NULL ;
AC_IMPLEMENT_EXTENSION_MODULE (theArxDLL);

class helloQtPalette : public hostQtPalette

{
DECLARE_DYNAMIC (helloQtPalette)

public:
helloQtPalette() {};

afx_msg void OnSize(UINT nType, int cx, int cy)
{



if (m_pWinwidget)
{
HWND wnd = (HWND)m_pWinWidget->windowHandle()->winId();
: :SetWindowPos(wnd, nullptr, @, ©, cx, cy, SWP_NOZORDER);
}
}

DECLARE_MESSAGE_MAP();
1

BEGIN_MESSAGE_MAP(helloQtPalette, hostQtPalette)
//{{AFX_MSG_MAP(helloQtPalette)
ON_WM_SIZE()
//}}AFX_MSG_MAP

END_MESSAGE_MAP ()

IMPLEMENT_DYNAMIC(helloQtPalette, hostQtPalette);

void helloQtPaletteCmd()
{
if (!m_pPalSet) {

CAcModuleResourceOverride ThisRes;

m_pPalSet = new hostUiPaletteSet();

m_pPalSet->Create(L"Test Qt Palette Set", WS _CHILD | WS _DLGFRAME | WS_VISIBLE, CRect(30, 50,
270, 300),

CWnd: :FromHandle(adsw_acadMainWnd()), PSS_SNAP | PSS_PROPERTIES _MENU | PSS_AUTO ROLLUP |

PSS_CLOSE_BUTTON);

m_pPalSet->EnableDocking(CBRS_ALIGN_ANY);

m_pPalSet->RestoreControlBar();

helloQtPalette* pPal = new helloQtPalette();
pPal->Create(WS_CHILD | WS_VISIBLE, L"Test Qt Palettel”, m_pPalSet, 0);
m_pPalSet->AddPalette(pPal);

QWidget* pPaletteWidgetl = pPal->paletteWidget();

QVBoxLayout* vbox = new QVBoxLayout(pPaletteWidgetl);
vbox->setSpacing(5);

vbox->setMargin(6);

QPushButton* pb = new QPushButton("Qt command button", pPaletteWidgetl);
pb->setObjectName("pb");

vbox->addWidget (pb);

QLabel* label = new QLabel("Some label", pPaletteWidgetl);
label->setObjectName("label");

vbox->addWidget(label);

QLineEdit* lel = new QLineEdit();

lel->setObjectName("1lel");

vbox->addWidget(lel);

QLineEdit* le2 = new QLineEdit();

le2->setObjectName("1le2");

vbox->addWidget(le2);

QLineEdit* le3 = new QLineEdit();

le3->setObjectName("1le3");

vbox->addWidget(le3);

vbox->addStretch();

//WId winId = le3->winId(); // Make Qt windows real HWND windows

pPaletteWidgetl->setLayout(vbox);
pPaletteWidgetl->show();

CRect cr;
m_pPalSet->GetClientRect(&cr);
pPal->OnSize(@, cr.Width(), cr.Height()); // Force to resize palette widget, needed when system
scale !1=100%
}
else {
m_pPalSet->Show(!m_pPalSet->IsWindowVisible());
}
}



extern "C" __declspec(dllexport) AcRx::AppRetCode
acrxEntryPoint (AcRx: :AppMsgCode msg, void* appId)

switch (msg)

{
case AcRx::kInitAppMsg:
acrxDynamicLinker->unlockApplication(appId);

acrxDynamicLinker->registerAppMDIAware(appId);

acedRegCmds->addCommand (L"HELLOQT_GROUP",
L"HELLOQTMODALDLG",

L"HELLOQTMODALDLG",
ACRX_CMD_TRANSPARENT,
helloQtModalDlgCmd);

acedRegCmds->addCommand (L"HELLOQT_GROUP",
L"HELLOQTPALETTE",

L"HELLOQTPALETTE",
ACRX_CMD_TRANSPARENT,
helloQtPaletteCmd);

break;

case AcRx::kUnloadAppMsg:
acedRegCmds->removeGroup(L"HELLOQT_GROUP");

if (m_pPalSet){
m_pPalSet->DestroyWindow();
m_pPalSet = 0;

}

break;

}

return AcRx::kRetOK;
}



